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Using Mendeley Desktop with Mendeley Cite   

As of September 2022, Mendeley Desktop is only available to existing users. New users should use 
Mendeley Reference Manager or another referencing tool. 
 
Mendeley Desktop allows you to store and organise your research sources as well as creating in-text 
references and reference lists in Word.  It can save a lot of time when completing larger research projects. 
 

Mendeley has an online version and a desktop version.  Your online version can be accessed at any time 
and will include the same references as your desktop account. 
 

Note that Mendeley is not a magic solution to referencing issues! It is only as good as the data it receives. 
You must still check your references to ensure accuracy. 
 

This guide covers using an existing account (Step 1), adding, organising and editing references (Step 2), 
using Mendeley Cite in Word (Step 3) and getting more help (Step 4). 

Step 1 – Access the software and choose a style 

You must already have a Mendeley account and have downloaded Mendeley Desktop. From September 
2022 you can no longer download this software.  
 
1. The first time you login to Mendeley Desktop, you will see an installation screen.  Tick Do not show me 

this message anymore and Close.  We will install extra options from the menus at the top instead.  
 

 
  

2. You will then be shown a tips box. Remove this using the X in the right hand corner.  
 

 

https://library.port.ac.uk/w903.html
https://library.port.ac.uk/reftools.html
https://www.mendeley.com/library
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3. Create a folder(s) using the options under My Library (on the left hand side) to organise your 
references.  
 

4. Choose your Referencing Style 
 

Mendeley automatically uses APA 7th edition as the referencing style.  
To change the default style to an alternative:  
 

• In Mendeley desktop select View and then Citation Style and then More Styles.  
 

 
 

• Search for the required style, select Use this Style and Done. 
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Step 2 – Add references, edit and organise your Mendeley account 

There are lots of ways to do this! Find the strategy that works best for you. Remember that whenever you 
bring in any new references, you must use Sync to refresh your library and view your new entries. 
 

 
As you add references, look at the record details screen for every entry and check the data is correct. To 
view your references in APA 7th format, as they will appear at the end of your work, (and so you can easily 
check if they need editing) click on View in Mendeley Desktop and select Library as Citations. You can also 
organise your references by using the options under My Library for your Recently Added/All Documents 
areas or by creating and moving references to additional folders (see below). 
 

   

A. Drag and Drop downloaded PDF journal articles: 

When you download a PDF from a database or another source, you can drag and drop this straight into 
your desktop account. You can also do this with any existing PDF files you have saved on your computer: 
 

1. Select the files you want in Windows Explorer or your Downloads folder on your computer/laptop 
2. Drag them over to your Mendeley Desktop window by holding down the left mouse button 
3. Let them go in the Mendeley Desktop main Library window when you see Copy or Add 
4. Mendeley will extract the details from the PDF and you can view the record in Recently Added 
5. Click on the record to see the reference details – edit anything that needs changing by clicking into 

the fields (e.g. add or change date/volumes etc.) or if Mendeley indicates the reference details 
need reviewing, use the Search feature to find complete details and then click Details are Correct 

6. Double-click on the record to open up the PDF, add notes/highlight etc. 

B. Add your existing Files/Folders and set up a Watch Folder 

If you don’t like drag/drop, use Add Files under the File tab to select PDFs from your computer/laptop. 
You can also set up a Watch Folder if you want to always save PDFs to the same place.  Mendeley will then 
automatically add any new PDFs in the Watch folder into your account (check Recently Added).  
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C. Install and use the web importer  

The Web Importer tool allows you to scrape reference details from book records, articles, webpages and 
other documents and add these directly into Mendeley Desktop.  It can be very useful but it doesn’t work 
with all website/library databases and you must check the accuracy of the details that are imported! 
 
i) Install the web importer from Mendeley Desktop: 
 

1. Select the Tools menu and Install Web Importer.  Choose the appropriate browser option and 
follow the instructions (Chrome generally works best for library resources, select Get Web Importer 
for Chrome and then Add to Chrome and Add Extension). 

2. A small red Mendeley M will appear on your browser (see image below). 
 

ii) Using the Web Importer tool 
 

1. Search for a record in the Library Catalogue or Discovery, or another resource of your choice (e.g. 
Google Scholar or a reliable website).  For the Library Catalogue, make sure you are viewing the full 
book details.  

2. Click on the M – a box will open up on the right of the screen.  This will contain the bibliographic 
details associated with the books/articles or other sources you are trying to import (see image 
below). 

3. CHECK AND EDIT the details to ensure they are as you would want them (use the pencil icon to 
make changes). The importer tool will not always pick up the correct information! If it has added a 
URL for a book that is only in printed format, you will need to remove this.  You may also need to 
add in or remove additional information.  If there is no published date, leave this field blank as 
Mendeley will automatically add n.d. (no date) for you.  

4. Save the record to your Library generally, or select a particular folder, using Add. 
5. If a PDF is available for the record, the Web Importer will try and include it in your Library. 

 

 

D. Export records directly from SCOPUS or elsewhere 

Some databases, such as Scopus, have a direct export to Mendeley. This is one of the easiest ways to get 
accurate references but it will not include the PDF of the full article.  You will need to download and add 
this in separately.  If there is no direct export option available, there might be a RIS option (see below). 
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D. Add records manually  

Some sources, such as information, data or reports from professional databases, cannot be added to 
Mendeley via any of the previous methods.  For these, go to File and choose Add Entry Manually. Select 
the type of resource (e.g. report) and fill in the appropriate details and save the record. 

E. Add records via RIS: a two step process 

Sometimes you may need to import a RIS file from a database like Discovery.  Only use this option if you 
want to download a large amount of results from a database or you can’t drag/drop the PDFs.  You can 
also use this method if you need to move references between different reference management tools. 
 

i. In the database: select the records you want and look for an Export option.   
Choose RIS format and save the file.   

ii. In Mendeley: choose the Import option under the File menu and select RIS.  
Locate your saved RIS file and add the records to your Library. 

 
Once all your records are in place, have a look at the range of options Mendeley provides to organise your 
research and annotate your pdfs.  
 
If you are away from your laptop/pc and you want to view your Mendeley library without downloading the 
desktop version, you can use Mendeley online: simply drag/drop PDFs and check/edit your records as 
normal, but you must Sync your Desktop version when you next login! 

Step 3 – Using Mendeley Cite in Word to create in-text citations and reference lists 

If you do not want to use Mendeley Cite, you can still generate a reference list (but not in-text citations) from 
Mendeley Desktop.  Simply select the records that you want to include in Desktop, right click and use the Copy As 
option and Formatted Citation.  Then open a Word document, right click and paste in your references.  Check and 
amend the records if there are any referencing errors and order appropriately. 

Mendeley Cite is the most up-to-date way to use Mendeley in Word.  It works in Word 2016 onwards.  It 
allows you to produce in-text citations as you write and generates a reference list for all your citations at 
the end.  It does this by pulling in and including your Mendeley records in your work as you type.  These 
entries are shown in separate boxes in Word and it is very important that you don’t edit or change these 
entries manually, all changes must be made within Mendeley or Mendeley Cite to ensure everything 
works correctly. 

If you have an older version of Word, install the Mendeley MS Word Plugin.  Look under the 
‘Tools’ menu in Mendeley and select ‘Install MS Word Plugin’. Further guidance is available. 

A. To install Mendeley Cite: 

1. Ensure you have saved and closed all current Word documents. 
2. From the Mendeley Desktop Tools menu, select Get Mendeley Cite and choose Get it now.   
3. If you are not already signed into your Microsoft Office account, you will be asked to do so. 

 

Staff and students using University of Portsmouth Microsoft software will need to get their 
Microsoft Office account or reset their Microsoft Office password. 

 

4. Once signed in, choose Get it now, agree to the terms and conditions and Continue. 
5. Choose Open in Word.  A new document will appear in Word entitled Mendeley Cite. 

https://www.mendeley.com/guides/desktop/03-organizing-documents
https://www.mendeley.com/guides/desktop/03-organizing-documents
https://www.mendeley.com/guides/desktop/04-read-highlight-annotate
https://www.mendeley.com/library/
https://www.mendeley.com/guides/using-citation-editor/
https://live.hornbill.com/uopservicedesk/servicemanager/selfservice2/raise/173/serviceRequest/964/
https://live.hornbill.com/uopservicedesk/servicemanager/selfservice2/raise/173/serviceRequest/964/
https://live.hornbill.com/uopservicedesk/catalog/new-service-request/com.hornbill.servicemanager/173/970/
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6. On the right hand side, you will see a New Office Add-in panel.  Choose Trust this add-in. 
7. The References bar will open at the top of your document and you will see a red Mendeley Cite 

icon (see image 1 below).  Click on the icon and it will open a Mendeley Cite panel on the right 
hand side. Choose Sign In and enter your Mendeley account details.  

8. Click on Citation Style and select APA 7th (or an alternative) from the list. Click the blue Update 
citation style button at the bottom of the panel to select your chosen style.  It will now appear 
ticked (see image 2 below).  
 

1.  

2.  3.  

B. In Word - inserting in-text citations 

1. Check that your Citation Style is set correctly and that you are searching within the correct folder 
(e.g. All References, Recently Added or an alternative) selected from the drop down menu (see 
image 3 above).  

2. Search for the author or title of the reference you want to use and select it using the tick box (you 
can select more than one reference to use in a sentence as required, see image 4 below).  

3. Click in your sentence where you want your citation to be added and select Insert 1 citation. 
4. The in-text reference will now appear in your sentence in your chosen reference style. 
5. Double click into your Word document to come out of the reference, and continue with your work. 
6. Repeat steps 2-5 above to add more references. 
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C. In Word – editing in-text citations 

1. When you add an in-text citation, if you want to make changes, click on the author and date at the 
top of the Cite panel (see image 4 below).  This will take you into the Edit Reference screen (see 
image 5 below).  You can also click on any in-text citation in your sentences to get the option to edit 
the reference from the top of the Cite panel.  

2. In Edit Reference, you can add a page number or suppress the author (useful if you only want the 
date to show in brackets), and/or add a prefix/suffix to your citation (see image 5 below). 

3. Make your edits and Save changes and Insert 1 citation.  If you have already inserted the citation 
and re-edited it, click off the citation in your Word document to carry on with your writing. 
 

4.      5.    

D. In Word – adding your reference list 

1. When you are ready, enter a couple of line breaks at the end of your work in preparation to insert 
your full reference list (use the Enter or Return keys).  If you are using APA 7th, type the heading 
References and leave another space.  

2. Click More in Mendeley Cite, choose Insert Bibliography and continue (see image 6 below).  Any 
references you have included in your sentences will now appear at the end of your work.  

3. Check your references carefully against APA 7th guidance (or your chosen style).  If there are errors, 
change these in Mendeley Desktop and then click on the Sync button (see image 7 below).  Return 
to Word and choose More in Mendeley Cite and Update from Library (see image 6 below). Your 
changes should now be brought across into your Word document. 
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6.    7.    
 

 
Example of how your in-text references and reference list may look 

 

   
 
 

Step 4 - Getting more help on Mendeley and Referencing 

For any technical problems installing Mendeley Cite, please contact Information Services on +44 
(0)23 9284 7777. 
 
Additional guidance from Mendeley includes: 

 
o Mendeley’s guidance for Desktop 
o Mendeley’s guidance for Mendeley Cite 

 
Referencing guidance includes: 
 

o University of Portsmouth reference guidance  
o Library’s 24/7 help service (for general referencing queries, not for specific advice on 

using Mendeley) 

https://www.mendeley.com/guides/desktop/
https://www.mendeley.com/guides/mendeley-cite/
https://library.port.ac.uk/referencing
https://library.port.ac.uk/help/
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